
www.ezcam.com

EZ-Mill 3D Machining Solids Tutorial

CNC Programming Simplified



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Copyright Notice 
This manual describes software that contains published and unpublished 
works of authorship proprietary to EZCAM Solutions, Inc.  It is made 
available for use and maintenance of our products.  Under copyright 
laws, this manual, or the software it describes may not be copied in 
whole, or in part, without prior written consent of EZCAM Solutions, 
Inc., except in normal software use. The information in this document is 
subject to change without notice and should not be construed as a 
commitment by EZCAM Solutions, Inc. 
 
 
All software package identifying names appearing herein prefaced with 
EZ are trademarks of EZCAM Solutions, Inc.  , All Rights Reserved. 
 
 
EZ-CAM® and any other references to EZCAM applications software 
are protected by 
 
Copyright 1999-2004 of EZCAM Solutions, Inc. 
All Rights Reserved. 
 
 
Printed Documentation 
Copyright 1999-2004 of EZCAM Solutions, Inc. 
All Rights Reserved. 
 



 

EZ-CAM 3-1 

 

OVERVIEW 
This tutorial begins with a simple surface geometry representative of a part model that 
might be imported from one of the popular solid modeling packages.  This tutorial can be 
performed with either EZ-MILL 3D or EZ-MILL Pro. It is important to remember 
however, that EZ-MILL 3D machining capabilities are limited to a maximum of 20 
surfaces per work step, so it may be necessary to refine your selection to just the surfaces 
needed for a particular operation when applying these strategies to other parts.   
Whenever practical it is best to select all surfaces, then localize the machining with 
boundary curves or other limiting techniques.  This method will minimize tedious surface 
picking and ensure there are no small sliver surfaces excluded, which could lead to an 
incorrect result or gouging toolpath. 
 
The focus of this tutorial is on how to apply the primary surface machining strategies, not 
on finding the most efficient method to machine the part.  After walking through these 
exercises using the suggested parameters, you are encouraged to alter the parameters and 
try different options and techniques.  It is best to understand how the various 
combinations work when applied to a well-defined simple part, before moving on to more 
complex applications. 
 
 

CAVITY MACHINING 
This tutorial will machine a part containing a drafted wall pocket with a convex spherical 
floor, and 4 though holes. While this part can be machined with many different strategies, 
this example focuses on introducing the most common surfacing methods, Constant Z and 
Vertical Projection.  We will also introduce the technique of creating 2D Curve geometry 
from 3D surface data.  We will machine the part using 5 work steps, two for surface 
roughing, two for surface finishing, and the last one for drilling. 
 

CHAPTER 3.  
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BASIC PROGRAMMING STEPS 
Before beginning the exercise let us first summarize the steps that will be followed. 
 
 
STEP 1.  Load (Import) the Surface Geometry of the Part to be machined 

The best method for exporting geometry from a solid modeling CAD 
system for use in EZ-CAM is to create an IGES trimmed surface 
model.  This exercise will begin with an IGES file saved from Rhino, 
our recommended low cost CAD modeling companion product. 

 
STEP 2.  Check Surface Directions 

Confirm that the surface normal directions (machining sides) are set 
correctly, and if necessary, reorient them. 

 
STEP 3.  Create auxiliary Curve Geometry from the 3D Surface Geometry 

We will use the XY intersection function to create several 2D curves to 
be used for localizing the 3D surface milling operations, and defining 
the 2D drilling path. 

 
STEP 4.  Create Machining Work Steps 

Create machining work steps, specify tool and operation parameters, 
select surfaces and/or Path Curves, and verify the toolpaths.  We will 
create rough surface milling operations leaving stock on all surfaces, 
then finish surface milling operations removing the remaining material 
leaving minimal cusps, and lastly, a simple drilling operation for the 
holes. 

 
STEP 5.  Check Material Removal and Surface Finish 

Check to make sure all material is removed and that the surface finish 
smoothness is acceptable.  We will define the machining stock then 
visualize the machining process using the Preview function. 

 
STEP 6.  Post Processing 

Post process the work steps to create the final machine code file for a 
specific machine/control. 

 
 

   
The EZ-MILL 3D Cavity Tutorial is set up in Inch with all Inputs 

and Dimensions in Inch ! 
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THE PART 
The following image shows the part we will machine.  It is a 4”x4” block that is 3” tall.  
There is a 3”x3” pocket with 5 degree drafted walls, and .375” radii corner fillets.  The 
floor of the pocket has a convex 8” spherical radius, and the depth from the top of the part 
to the top of the sphere is 1”.  There are .25" radii fillets between the walls and the floor, 
and there are four .5” diameter thru holes equally spaced at 3.25” between centers. 
 
 
 

 
 
 

Picture 3-1 
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SETTING THE PREFERENCES 
This tutorial uses geometry defined in inch units, and all parameters and output will based 
on these units.  Before beginning we must first make sure the system settings are 
compatible with the exercise.  
 
1. Select ”New” command from the “File” menu to restart EZ-Mill and to clear the 

memory before continuing with the tutorial. Make sure that one of the EZ-Mill levels 
is active and press OK to start over. 

 

 
 
 

  
 

The “New” dialog is also used to switch between the EZ-Mill and 
EZ-Turn module. Before the dialog opens, the system checks the 
software protection key for activated modules. Modules or levels 
that are not activated will be marked by appended “DEMO” text. 
When working in “Demo” (evaluation) mode, it is not possible to 
print or save data. The corresponding “Save”, “Save as” and 
“Print” commands are disabled. 
 
When closing the EZCAM application, the system automatically 
stores the last used level as default for the next session. 

 
2. Select ”Setup” command from the “View” menu 
 
3. Type “0” for “X Center”, “0” for “Y Center” and “5” for “Size”. 

This sets the window size from the edge of the window to the center of the window, 
allowing enough room to see all of the part as it is created. 
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4. Select “Inch” option button as the parts input dimension system. 
 
5. Click the “Background” list box and select “White”. 
 
6. Check the box "Blank Verify" on the right. This will cause verified tool paths to be 

blanked every time the view is changing or the screen is redrawn. 
 
7. Un-Check "Show Surf/Curve Direction". This will hide the small arrows indicating 

the surface normals and curve directions. It can later be activated at any time. 
 
8. Check "Save as Default". The system will store all dialog settings as defaults for 

future sessions. 
 
9. After the preferences have been correctly set, click OK. 
 

 
 
 
The initial setup for the EZ-MILL 3D Cavity tutorial is now complete. Continue with the 
next section to create the geometry necessary for this part. 
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LOADING THE SURFACE GEOMETRY 
We will begin the exercise by loading the surface geometry that represents our part.  
There are 2 different procedures that can be followed, you can either load a trimmed 
surface IGES file directly into EZ-MILL, or if you have installed the Rhino evaluation 
program, you can load the Rhino *.3dm sample file into Rhino, then copy and paste it 
into EZ-MILL using the clipboard. The following section will explain both methods. 
 
 

LOADING THE SURFACE DATA VIA IGES IMPORT 
The IGES file containing the trimmed surface geometry has already been copied into the 
“EZCAMW\MILLPARTS” folder by the EZ-CAM setup. Follow the steps below to load 
the data. 
 

 
 

Picture 3-2 
 
 
1. Select “Open” command from the “File” menu to open the file dialog. In Picture 3-2 

you can see the dialog displayed on a Windows XP professional workstation system. 
This dialog may vary according to the version of the Windows operating system 
running on your machine. 
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2. Select the folder “EZCAMW \ MILLPARTS” on the drive where you installed the 

software 
 
3. In the ”Files of Type” list select “IGES (*.igs)”. 
 
4. Select the file “CavityTutorial.igs” and click the “Open” button. The imported 

surface geometry should then appear as shown in Picture 3-3. 
 
 
 

 
 

Picture 3-3 
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COPY AND PASTING THE MODEL FROM RHINO 
The Rhino package is an extensive nurbs-modeling tool designed for the Microsoft 
Windows platform. You can find the setup files for the Rhino evaluation version on the 
EZCAM setup CD. The file with the Rhino model used in this tutorial has already been 
copied into the “EZCAMW\MILLPARTS” folder by the setup. 
 
 
1. Start the Rhino application and select “Open” command from the “File” menu to 

open the file dialog. 
 

2. Navigate to the “EZCAMW \ MILLPARTS” folder on the drive where you installed 
the EZCAM software and pick the file “CavityTutorial.3dm”. Click the “Open” 
button to load the file. With a left-mouse click on the “Render Viewport” command 
icon you can get a shaded view of the part. The model should now appear as shown 
in Picture 3-4. 

 
Render Viewport 

 
 

 
 

Picture 3-4 



EZ-MILL 3D CAVITY TUTORIAL 

EZ-CAM 3-9 

 
3. Next step is to copy all rhino entities to the clipboard. Therefore click the “Cancel” 

command to ensure no other command is active and select the model by dragging a 
frame around it using the cursor. As you can see in Picture 3-5, the selected entities 
are then highlighted in yellow. Finally use the “Copy to Clipboard” command to 
copy everything to the windows clipboard. 

  
Cancel Copy to Clipboard  (Ctrl+C) 

 
 

 
 

Picture 3-5 
 
 
4. Switch back to the EZ-MILL application and choose the “Paste from Rhino” 

command (or Ctrl+V) from the “Edit” menu to paste the surface geometry from the 
clipboard into the current EZ-MILL session window. Note that the coordinate system 
used in Rhino is matched to the World coordinate system of EZ-MILL. 
 

5. You can now switch back to Rhino and exit the application by choosing File – Exit. 
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CHECKING THE SURFACE NORMALS 
Each surface of a model contains a direction “normal” which points to the outside 
(machining side) of the surface. Some machining cycles of EZ-MILL (Constant Z and 
Surface) use the surface normal when calculating the toolpath, so it is best to ensure they 
are set correctly before proceeding. In most cases when loading surfaces from a solid, the 
surface normals will already be set correctly to the outside. However, in some cases they 
may not all be correct, and it will be necessary to set them manually. Following are the 
steps to confirm and correct the surface machining side. 
 
1. The best method to determine the machining side orientation is to shade the model.  

Surfaces that are correctly oriented will display in a light blue color, and those 
incorrectly oriented will display in a darker blue. Choose the “Shade” command from 
the “View / View Control” menu to shade the model. 

 
Shade 

 
 

 
 

 
 

Machining Sides set correctly 
for all Surfaces 

Machining Sides set Incorrectly 
for Outer Side of Block 

 
 
2. If the machining sides are not set correctly, EZ-MILL has a quick and effective 

method for setting them when the surfaces form a closed volume, as would be the 
case for a solid model. To use this method, choose the “Solid Surfaces “ command 
from the “Surfaces / Machining Side” menu.  When working with surfaces that do 
not form a closed volume, one of the other Machining Side options such as “Toggle 
Surface” must be used to set them manually.  This step is not necessary for our 
tutorial geometry since the machining sides are already set correctly. 
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When setting individual surface machining sides it is sometimes 
useful to turn off surfaces shading and activate display of the 
direction indicator arrows by checking the “Show Surface/Curve 
Direction“ option found on the “Setup” dialog (see “View” 
menu). 

 
 

DEFINING AUXILIARY CURVE GEOMETRY 
Since there is no wire frame geometry included with the surface geometry, we will use 
the “XY Intersection” function to create the curves we will need for our machining 
boundaries and drilling path. A curve around the top of the pocket will be used for 
Pocketing and Zig-Zag projection type cycles to rough and finish the spherical floor of 
the cavity. This same curve will also be used to restrict the “Constant Z” Contouring 
finishing cycle to prevent cuts from occurring outside this curve along the outer walls of 
the block.  A second curve consisting of the four holes will finally be used to define our 
drilling path. 
 
 
1. To create the intersection curves choose the “XY Intersection” command from the 

“Curves“ menu and accept the default name “Crv1” for the new curve 

 
XY Intersection 

 
  

 
2. Now there are two ways to define the Z-axis level at which the intersection profiles 

will be calculated. We can use the cursor to right-click on one of the top corners of 
the block using the “Snap All” selection option, or simply enter “0” into the “Z” field 
of the “Value Entry Box”. Finally press ENTER to start the calculation process. You 
can see the result in Picture 3-6. 

 
Snap All 

 
 

 Right-Click on Corner to select it’s 
current Z Level (0) 
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Picture 3-6 
 
 
 

   
Using the left mouse button when selecting one of the top corners 
of the block, starts the calculation process immediately without 
the need to press the ENTER button. 
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CONNECTING THE DRILLING PATH CURVE 
The next step will be to combine the 4 separate curves created for each hole into a single 
curve connecting them with rapid links. 
 
 
1. First we need to select one of the circular curves as the “Current Curve”. The other 

curves representing the three remaining holes will later be appended to this profile. 
Select the “Current Curve” status button from the bottom of the EZCAM window. 
Then use the cursor to pick the “Crv1-2” from the “Selection List Box” on the right 
side of the screen. Now the status button should display “Curve: Crv1-2”. 
 

  
 
2. Next, select the “Copy/Append” command from the “Curves” menu and pick the 

curves Crv1-6, Crv1-5, and Crv1-4, either directly from the viewport or the 
“Selection List Box”. Note how the selected curves are removed from the list and a 
dashed line (rapid link) now connects them to our original curve Crv1-2. See Picture 
3-7.  

 
Copy/Append 

 
 

 
 
 

Picture 3-7 
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CREATING THE PART PROGRAM 
Now that we have created the auxiliary curve geometry needed for our machining cycles, 
we are ready to begin defining the work steps to machine the part. Each work step uses a 
specific cycle (Constant-Z, Pocketing, etc.) along with its associated tool settings and 
parameters to create a toolpath that machines the assigned curves and/or surfaces.  Our 
part program will consist of the following work steps. 
 
 

Work Step ID Purpose 

Rough1 

Rough the cavity down to a depth of .975 (.025 above the top of 
the spherical floor) leaving a 2D Stock Allowance of .025, using a 
Constant-Z cycle with a Pocketing toolpath pattern generated 
inside of each surface slice boundary. 

Rough2 
 

Rough the floor surfaces of the cavity leaving a 3D Surface 
Allowance of .025, using a Pocketing cycle with the toolpath 
pattern generated inside curve Crv1 and projected onto the floor 
surfaces. 

Finish1 
 

Finish the drafted walls of the cavity inside Crv1 to a depth of 1.0 
using a Constant-Z cycle with a Contour toolpath generated 
along each surface slice boundary. 

Finish2 

Finish the floor surfaces of the cavity using a Zig-Zag cycle with 
the toolpath pattern generated inside of curve Crv1 and projected 
onto the floor surfaces.  An Upper Check plane set to Z-1.0 will 
be used to prevent the toolpath from machining the previously 
finished wall surfaces. 

Drill1 
Drill the 4 holes to a depth of 3.15 using curve Crv1-2 as the 
path. 

 
 
 



EZ-MILL 3D CAVITY TUTORIAL 

EZ-CAM 3-15 

CREATING „ROUGH1‰ – CONSTANT Z POCKETING 
Our first work step will use the “Constant-Z” cycle to rough out the pocket cavity in .25 
depth levels with a Pocketing toolpath pattern. Since the walls of this pocket have a 
uniform draft angle it would also be possible to machine it using just the standard 
“Pocketing” cycle, machining curve “Crv1” with a specified draft angle of 5 degrees.  But 
for the purpose of introducing the more generalized surfaced based approach, we will use 
the “Constant-Z” cycle using only surface data.  
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab. 
 

 
 
2. Press the “New” button and input “Rough1” as the new Work Step ID. Confirm with 

OK. 

 
 
3. Select “Constant Z” from the cycle list. As the pocket boundaries will be 

automatically calculated by the cycle, set the path curve list box to “none”. 
 

 
 
 
4. On the “Tool Info” tab, change the settings according to the table below and ensure 

that all parameters are set as shown in Picture 3-8. 
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Dialog Field Value Comment 

Type Bull Bull type endmill 

Number 1 Tool number in tool magazine. 

Diameter (Bot.) 0.5 Defines the bottom diameter of the tool  

Corner Radius 0.125 Corner radius at tooltip 

Length 1.5 Tool length used for preview simulation 

Z Surface 0 Set our Z surface to the top of the block 

Z Rapid 1 Rapid positioning plane 

Z Clear .1 Plunge plane (Rapid to Feedrate) 

Z Depth 0.975 
Set final depth to 0.025 above the spherical 
floor 

Z Step 0.25 Incremental depth per Z-level pass 

Plg.Dis./Pitch 0.05 

Helix-Rad. 0.5 

In order to gently enter into each Depth Level 
without plunging, we define a helical entry by 
specifying a Pitch and Helix Radius. 
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Picture 3-8 
 
 
5. On the “Cycle Data” tab we set our “Stock Allowance” to “0.025” to ensure material 

remains along the walls to be removed later with our finishing operation. It is 
important to remember that this allowance is in 2D and is applied to the calculated 
slice boundaries only. The “Step Over” between passes is set to “0.25” (the diameter 
of the flat on the bottom of our Bull endmill). The remaining parameters should be 
set as shown in Picture 3-9. 
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Picture 3-9 
 
 
6. Next, select the “3D Cycle Data” tab and set the “Operation” to Pocketing. Turn ON 

the “Gouge Check” option that tells the system to determine the machining side of 
the slice boundaries based on the surface machining side, rather than a nested loop 
method, which starts pocketing inside the outermost loop and alternating thereafter. 
Check that the remaining parameters are set as shown in Picture 3-10 and close the 
dialog. 
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Picture 3-10 
 
 
7. Now we have to select the surfaces that will be machined. Normally this is done 

using the “Add Surf” button below the “Work Step Surfaces” table on the “3D Cycle 
Data” tab. As this only allows selection from a list it is not very flexible, especially 
when trying to select a specific surface from a huge list. Therefore it’s often easier to 
pick the surfaces on the screen. In the next section we’ll show you how to do this. 
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First select the “Select Cut Surfaces” command from the “Machining” menu (or 
Icon) and activate the “Verify” mode. As in many cases, there is no need to refine the 
selection, so we’ll simply select all part surfaces using the “Select All” command. 
Finally press ENTER to complete selection and let the system add the entities to the 
“Work Step Surfaces” table. 

   
Select Cut 
Surfaces 

Verify Mode Select All 

 
 
8. Click the “Verify” button and the system starts calculating the toolpath. See Picture 

3-11. 

 
Verify 

 
 

Picture 3-11 
 
 
 

The Work Step #1 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 



EZ-MILL 3D CAVITY TUTORIAL 

EZ-CAM 3-21 

CREATING WORK STEP „ROUGH2‰ – PROJECTED POCKETING 
Our second machining work step will rough the spherical floor of the pocket cavity using 
a Pocketing cycle and projecting the toolpath onto the floor. The pocketing pattern will 
allow our tool to enter the material near the top of the sphere were there is the least 
material, then gradually step outward removing more and more material. 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab, press the “New” 
button and input “Rough2” as the new Work Step ID. Confirm with OK. 
 

 
 
2. Select “Pocketing” from the cycle list and “Crv1” as the path curve. 

 

 
 
 
3. On the “Tool Info” tab, change the settings according to the table below. All other 

parameters are identical to the previous work step. Check and ensure that everything 
is set as shown in Picture 3-12. 
 

Dialog Field Value Comment 

Type Ball Ball type endmill 

Number 2 Tool number in tool magazine. 

Diameter (Bot.) 0.375 Defines the full diameter of the tool  

Z Depth 0 Pocketing depth defined by surfaces 

Z Step 0 For finishing no step is required 
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Picture 3-12 
 
 
4. On the “Cycle Data” tab we will set our “Stock Allowance” to “0.1” to ensure the 

pocket pattern that is to be projected to the floor is far enough away from the walls to 
prevent it from climbing them. Since we are roughing and are not too concerned with 
the size of the cusps, we will set our “Step Over” between passes to”0.1”. The 
remaining parameters should be set as shown in Picture 3-13. 
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Picture 3-13 
 
 
5. Next, go to the “3D Cycle Data” tab to define the machining surfaces as in the 

previous work step, but this time with the dialog still open. First select the “Select 
Cut Surfaces” command and activate the “Verify” mode. Then use the “Select All” 
command to mark all part surfaces and press ENTER to add them to the “Work Step 
Surfaces” table. 

   
Select Cut 
Surfaces 

Verify Mode Select All 
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6. Once the surfaces are selected we can set their “Fin Allow” to “0.025” to ensure there 

is stock remaining on the floor of the pocket for our subsequent finishing operation. 
Ensure that everything else is set as shown in Picture 3-14 and close the dialog. 

 

 
 

Picture 3-14 
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7. Click the “Verify” button and the system starts calculating the toolpath as shown in 

Picture 3-15. 

 
Verify 

 

 
 

Picture 3-15 
 
 
 

The Work Step #2 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP „FINISH1‰ – CONSTANT Z CONTOURING 
Our third machining work step will finish the drafted walls using a contouring operation 
with the “Constant-Z” cycle. We will machine the walls in .025 depth steps to the depth 
of 1.0 (the top of the sphere) to prevent undesirable contour passes from occurring on the 
spherical floor below this level.  
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab, press the “New” 
button and input “Finish1” as the new Work Step ID. Confirm with OK. 
 

 
 
2. Select “Constant Z” from the cycle list and “Crv1” as the path curve in order to 

restrict the contouring cuts to those inside the cavity, excluding those that would 
otherwise be generated along the outer walls of the block. 
 

 
 
 
3. On the “Tool Info” tab, change the settings according to the table below and ensure 

that all parameters are set as shown in Picture 3-16. 
 

Dialog Field Value Comment 

Type Ball Ball type endmill 

Number 3 New tool number for finishing operation 

Diameter (Bot.) 0.375 Defines the full diameter of the tool  

Z Depth 1 Max depth of computed toolpath 

Z Step 0.025 Incremental depth per Z-level pass 
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Picture 3-16 
 
 
4. Next, go to the “3D Cycle Data” tab to define the machining surfaces as in the 

previous work step. First select the “Select Cut Surfaces” command and activate the 
“Verify” mode. Then use the “Select All” command to mark all part surfaces and 
press ENTER to add them to the “Work Step Surfaces” table. 

   
Select Cut 
Surfaces 

Verify Mode Select All 
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5. Once the surfaces are selected, their “Fin Allow” is set to “0” since we are finishing 

the walls and do not want to apply a 3D allowance to the surfaces. Also turn OFF the 
“Gouge Check” option since it would tell the system to remove any contour passes 
resulting from undercut regions. Since our part does not contain any undercuts there 
is no need to enable this function, and doing so would just add further to the 
computation time. Finally check that “Operation” is set to “Contouring” to compute 
contour passes only. Everything else should be set as shown in Picture 3-17.  

 

 
 

Picture 3-17 



EZ-MILL 3D CAVITY TUTORIAL 

EZ-CAM 3-29 

 
6. On the “Cycle Data” tab we will set our “Stock Allowance” to “0” since we are 

finishing the walls and do not want to apply a 2D allowance to the calculated contour 
slices. “Total Stock” and “Cut Step” are also set to “0” since there is no need to apply 
additional side passes to each contour. The remaining parameters should be set as 
shown in Picture 3-18. Finally close the dialog. 

 

 
 

Picture 3-18 
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7. Click the “Verify” button and the system starts calculating the toolpath as shown in 

Picture 3-19. 

 
Verify 

 

 
 

Picture 3-19 
 
 
 

The Work Step #3 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP „FINISH2‰ – PROJECTED ZIG-ZAG 
The fourth machining work step will finish the spherical floor of the pocket cavity using 
the Zig-Zag cycle by projecting it’s toolpath onto the floor. The zigzag pattern will allow 
our tool to step over leaving minimal cusps, and we can use the “Variable Step Over” 
option to automatically reduce the step over for cuts occurring along the walls. 
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab, press the “New” 
button and input “Finish2” as the new Work Step ID. Confirm with OK. 
 

 
 
 
2. Select “Zig-Zag” from the cycle list and “Crv1” as the pocket boundary from the 

path curve list box. 
 

 
 
 
3. On the “Tool Info” tab, we’ll change the “Depth” and “Step” to “0”. This is because 

we are finishing and there is no need to adjust the Depth of the projected toolpath. 
All other parameters are identical to the previous work step. Check and ensure that 
everything is set as shown in Picture 3-20. 
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Picture 3-20 
 
 
4. On the “Cycle Data” tab, “Stock Allowance” is set to “0”. This ensures the zigzag 

pattern that is to be projected to the floor covers the entire area within our curve Crv1 
boundary. Since we want to leave minimal cusps on the floor, our “Step Over” 
distance between passes is set to “0.025”. We will also turn ON the “Variable Step 
Over” option to automatically reduce the distance between cuts occurring along the 
walls, where the surface slope is steepest. The remaining parameters should be set as 
shown in Picture 3-21. 
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Picture 3-21 
 
 
5. Next, go to the “3D Cycle Data” tab to define the machining surfaces as in the 

previous work step. First select the “Select Cut Surfaces” command and activate the 
“Verify” mode. Then use the “Select All” command to mark all part surfaces and 
press ENTER to add them to the “Work Step Surfaces” table. 

   
Select Cut 
Surfaces 

Verify Mode Select All 
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6. Once the surfaces are selected, check that their “Fin Allow” is “0” to ensure there is 

no stock remaining on the floor of the pocket after our finishing operation is 
complete. In order to prevent our projected zigzag toolpath from climbing the cavity 
walls and re-cutting areas that were finished with our previous “Finish1” work step, 
we will specify an “Upper Check Plane” to “Skip” everything above the “Z Level” of 
“-1.0” (the absolute Depth to which we finished in the previous work step). Ensure 
that everything else is set as shown in Picture 3-22 and close the dialog. 

 

 
 

Picture 3-22 
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7. Click the “Verify” button and the system starts calculating the toolpath. See Picture 

3-23. 

 
Verify 

 

 
 

Picture 3-23 
 
 
 

The Work Step #4 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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CREATING WORK STEP „DRILL1‰ – DRILLING 
Our last machining work step will drill the .5 diameter though holes using the “Chip 
Breaking” drill cycle.  
 
 
1. Select the “Work Step Data” command in the “Machining” menu to open the “Work 

Step Data” dialog. Once it is open switch to the “Tool Info” tab, press the “New” 
button and input “Drill1” as the new Work Step ID. Confirm with OK. 
 

 
 
2. Select “Chip Break” from the cycle list and “Crv1-2” as the path curve. 

 

 
 
 
3. On the “Tool Info” tab, we define a new tool and adjust the depth settings as shown 

in the table below. Ensure that everything else is set as shown in Picture 3-24 and 
close the dialog. 
 

Dialog Field Value Comment 

Type Drill Ball type endmill 

Number 4 Tool number in tool magazine. 

Diameter (Bot.) 0.5 Defines the full diameter of the tool  

Length 3.25 Tool length used for preview simulation 

Z Surface 0 Set absolute reference plane for operation 

Z Depth 3.15 Drill depth (tooltip) 

Z Step 0.25 Required step for chip breaking 
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Picture 3-24 
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4. Click the “Verify” button and the system starts calculating the toolpath as shown in 

Picture 3-25. 

 
Verify 

 

 
 

Picture 3-25 
 
 
 

The Work Step #5 is now complete. Hit the “Redraw” button  to refresh the 
screen and remove the verified tool path display. 
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VIEW ESTIMATED MACHINING TIMES 
Now that all work steps have been defined and verified we can view the estimated 
machining times (not including rapid traverse or tool change times) displayed in the 
“Time” column of the integrated spreadsheet. 
 
 
1. Open the spreadsheet by selecting the “Show Spreadsheet” command from the 

“Machining” menu or the toolbar.  

 
Show Spreadsheet 

 
In case not all work steps are displayed, move the cursor to the upper border of the 
spreadsheet until the mouse pointer changes to the double–arrow. Then keep the left 
mouse button pressed while dragging the cursor up to the size you want. 

 

 
 
2. Now click anywhere into the spreadsheet to display the bottom slider with it’s 

left/right arrows and use the right arrow until the “Time” column gets visible on the 
screen. Please note that the displayed time is based on what was previously verified. 
If any toolpath verification process was terminated, the estimated time in the 
corresponding column section may not reflect the correct value. 
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If you are not sure that all work steps have been verified correctly, 
or have started a new session and loaded your previously saved 
work, use the “Verify All” command from the “Machining” menu. 
It performs an on-screen verification of all work steps in memory, 
in the machining order. The total machining time (not including 
rapid traverse or tool change time) is displayed in a dialog box at 
the end of the verification process as shown in Picture 3-26. 

 
Verify All  

 

 
 

Picture 3-26 
 

 It is also very important for the “3D Preview” solid simulation 
that is explained later to have all toolpaths verified correctly. Only 
tool moves that have been verified will be simulated. 
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3D SOLID MODEL PREVIEW 
One of the most powerful EZ-CAM features is the 3D solid preview function. This 
function shows an animated tool cutting a solid model of the programmed part. After 
previewing our program we are left with an accurate solid model representation, which 
allows us to closely examine the surface finish and resulting part details. Once the 
simulation is finished or interrupted by the user pressing “Esc” key, all dynamic view 
commands to rotate, zoom or move the simulated model on the screen are available. If no 
stock was defined prior to calling the “3D Preview” command, the system automatically 
calculates the stock size, according to the maximum calculated tool movements. For the 
tutorial we will manually assign the stock size using the “Stock & Optimization Setup” 
dialog that can be opened from the “Machining” menu. 
 
 
1. Select the “Stock & Optimization Setup” command from the “Machining” menu and 

input the values as shown in Picture 3-27. Close the dialog with OK. 
 

 
 

Picture 3-27 
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2. Before starting the preview select the “Isometric View” command. Then start the 

simulation using “3D Preview” command from the “Machining” menu or the 
corresponding button. The simulation speed can be controlled any time by pressing 
one of the numeric keyboard buttons, ranging from 1 (slowest) to 9 (fastest). See 
Picture 3-28.  

  
View 
Isometric 

3D Preview 

 

 
 

Picture 3-28 
 
 
3. Once the simulation stopped you can change the on-screen view by using the 

dynamic view commands (Rotate, Pan, Zoom) from the “View / Dynamic Viewing” 
menu. 

   
Dynamic Rotate Dynamic Zoom Dynamic Pan
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SAVING THE PART PROGRAM 
It is very important to save the newly created or edited part from memory to disk 
periodically during a session, as well as at the end to ensure that no information is lost. 
The “Save” and “Save as” commands under the “File” menu transfer files from system 
memory to hard disk or other media. In EZ-MILL, the part information is stored in three 
different file types. The “Part” file using the extension "3DP", the associated “Geometry” 
file with extension "GEO" and the surface file with the extension “3GX”. 
 
File Type  : GEOMETRY 
Extension : GEO 
Data  : Geometry Elements (lines, arcs, etc.), Curves, 
                               Surface Boundary Curves (hidden entities) 

  User Coordinate Systems (UCS) 
 
File Type  : PART Files 
Extension : 3DP 
Data     : Work Step Data (Technology & Machining Information) 
 
File Type  : SURFACE Files 
Extension : 3GX 
Data     : Surface Data 
 
There is no specific rule what should be saved first. Of course, if there is only one kind of 
data in memory (Work Steps or Geometry) the “Save as” dialog will automatically be set 
to the correct file type. 
 

 
 

Picture 3-29 



CHAPTER 3 

3-44 EZ-CAM 

 
1. Select the “Save as” command from the “File” menu. 
 
2. Select the appropriate drive and folder where the geometry and part files should be 

stored. You can use the “EZCAMW \ MILLPARTS” folder that was automatically 
created by the setup routine. 

 
3. Select “Part Files (*.3dp)” from the “Save as type” list box to save the machining 

data first. 
 
4. Type the new filename “CavityTutorial” in the “File Name” box and click the “Save” 

button. The file extension is added automatically. See Picture 3-29. 
 
5. Repeat steps 1 to 4 to save the geometry and surface information as well. Select the 

appropriate file type from the “Save as type” list box. This automatically changes 
current file extension, but keeps same filename as used previously when storing the 
geometry data. 

 

   
If you have already saved the geometry, the software 
automatically inserts a part file with the same name but different 
extension (*.3DP) in the “Save” menu when the first Work Step is 
created. All you have to do is to select “Save All” option from the 
“File” menu or the corresponding toolbar button. 
 

 
 
Save 
All 

 

 
 
 
 
 

 

The software will save and overwrite the existing files without 
any screen prompt. You can use this command anytime for fast 
saving of your work. 
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It is not possible to save data when the software is running in 
evaluation mode. The “Save”, “Save as” and “Print” commands 
are disabled. 

 
 

CREATING CNC CODE 
Now that the part program has been created, it must be converted to run on a NC control 
by running the “Post” command with the appropriate “Post-Processor” for your machine. 
 
 
1. Select “Post” command in the “Machining” menu to open the “Post Process” dialog. 

 
Post 

 

 
 

Picture 3-30 
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2. First you need to select the postprocessor. If the one desired is already loaded and 

displayed in the section “CNC-File”, continue to the next step. Otherwise use the 
“Change” button to browse your system for a different one. For this tutorial you may 
use the “FAN-DEMO.CNC” post (standard inch post that creates Fanuc style code). 

 

   
 

Standard postprocessor folders created by the EZ-CAM v14 setup: 
 
INCH 
<DRIVE>: \ EZCAMW \ EZCAM14 \ MILLINCHPOST 
 
METRIC 
<DRIVE>: \ EZCAMW \ EZCAM14 \ MILLMETRICPOST 

 
3. Select the “Toolpath” option from the “Listings” list box to watch the process by 

viewing the toolpath that is created parallel to the computed NC code. Displaying the 
G-Code as in the other tutorials makes no sense, since in 3D programming the text 
display would increase overall computing time drastically. 

 
4. Activate (check) the “EZ-DNC” option. This will automatically start the “EZ-DNC” 

application when posting of the part file is finished and load the newly created file 
for sending it top the machine using the serial port. See Chapter 6 “Communication 
with the Control” for more information about EZ-DNC. 

 
5. Next is the “G-Code File” section. Here, the default name and folder for the 

computed program file is displayed. The name is taken from the part file that was 
previously saved. The default directory is “EZCAMW\MILLGCODE”. 

 

   
 

Ensure that part file and postprocessor share the same dimension 
unit (“Inch” for this tutorial). The system will generate a 
“Dimension Unit Conflict” message, but then automatically scale 
the NC-Code according to the dimension specified in the 
postprocessor.  
 
View the online help for more information about the “Setup” 
dialog located in the “View” menu. 
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6. Click the “Post” button to start posting. Once all Work Steps have been processed, a 

final message as shown in Picture 3-31 is displayed. 
 
 

 
 

Picture 3-31 
 
 
7. Finally click the OK button to close the message dialog box 
 
 

Congratulations! 
 

You've completed the EZ-MILL 3D Cavity Tutorial ! 
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